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Launch Smart Tiles

Launch Smart Tiles
Launch the Smart Tiles application by selectingSurveillance>Smart Tiles from Telenium
Manager.
The Telenium Smart Tiles "Click Once" dialog informs the user that it is looking for updates on
the users server andwill automatically install updates if there are any. Once the download is
complete, the dialog will close and the Telenium Smart Tiles application will open.

Figure 1: Click Once Dialog
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Smart Tiles

Smart Tiles
Telenium's Smart Tiles is a combination of multiple network management applications
displayed in a single window. The application helps simplify tasks by reducing the number of
application windows that are opened at one time.

Dashboard
The dashboard is a window of information that is comprised of smart tiles. Each tile serves a
different function that can be related to another tile but is not required to be. Tiles can be
docked, grouped, andmoved by clicking a tile header and dragging with the mouse. Once a tile
is docked it can also be pinned, set to auto hide, or hidden manually using the button. Click
the [Refresh] button in the "Smart Tile" ribbon group to refresh the tiles data.

View Dashboards
Multiple dashboard layouts are supported. Users can create and view a number of different
dashboard layouts that can serve a variety of tasks. Dashboard layouts are stored in the
Telenium database. Depending on access, the user can choose from the list of available
dashboard layouts in the menu in the option.
If a user only has access to a single dashboard layout, the dashboard layout name in the
interface cannot be selected and changed. If a user has access to multiple dashboard layouts
they are able to change the currently displayed dashboard in the Smart Tiles application or
open additional dashboards in new windows.

Figure 2: View Dashboard
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Smart Tiles

Create a Dashboard
System administrators can create new dashboard layouts. Admins have access to a list of all
available smart tiles from within the application. They can open new tiles, arrange them, define
their entity reference, and lock that reference within the main display. Once a new dashboard
is created they can save the layout for other users to use in the menu. System admins can
also make changes to existing layouts.
Dashboard layouts can be assigned to individual users, to groups of users, and assigned
globally. Manage, view and assign dashboards in the tab in the option. Each
user will have one or more default starting dashboards associated with their user account in
Telenium.

Figure 3: Create a Dashboard

Font Size
The "Font" ribbon group is located under the Home tab in the Smart Tiles header. The available
options in the ribbon group are [Increase Size] +, [Decrease Size] -, and [Reset]. Click the
corresponding button to increase and decrease the size of the font across the application and its
tiles. The buttons function per click and increase or decrease text sizes by one point per click.
The set magnification persists across all dashboards and instances of Smart Tiles for the current
user.

Figure 4: Font Size Ribbon Group
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Smart Tiles

Available Tiles
Administrators can lock tiles to restrict which smart tiles are available to other non-admin
users. Admins that are logged into Smart Tiles can navigate to File>Smart Tiles and toggle
which tiles are available by clicking the button in the top right corner of each tile thumbnail.

Faded tiles are disabled and require a valid license to be enabled.

Figure 5: Available and Unavailable

Users without System Admin. or System Configurator privileges will not be able to see
unavailable smart tiles on their dashboard. The privileges are set in the zLogon record of each
user. A Telenium user with 'N' in their System Admin. or System Configurator User
Identification privileges will not see any smart tile data that is set to "Unavailable".

Figure 6: User Identification

If a non-admin user opens a dashboard that contains an unavailable tile, the tile is still
displayed in the appropriate dashboard location but the tiles contents is replacedwith a "tile is
locked and currently unavailable" message.

Figure 7: Locked Tile Dashboard Example
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Smart Tiles

Parent and Context of Smart Tiles
The Smart Tiles ribbon adds tabs depending on what tiles are active. Each smart tile has their
own set of tools that open in tabs on the ribbon. Open tiles in the dashboard by selecting
then and then double-clicking the desired tile.
Each smart tile serves a different purpose but tiles can interact with each other in the
dashboard by parenting a tile to a child tile. Use the [Parent] button in the "Parent & Default
Context" ribbon group to assign a parent tile to the selected tile. e.g., populate the "Alarm List"
tile by making the "AOR" tile the parent tile and then clicking an AOR button. Tiles can also be
populated by clicking and dragging a record/entity from one tile and dropped onto another.

Unparent a tile by selecting "No Parent" from the [Parent] drop-down.

Some tiles display information based on a single Telenium record reference. That record
reference may be statically defined in the dashboard layout or it may be defined based on an
entity reference associated with the dashboard layout.
Each tile can support up to 10 different context tabs. If more than 10 sources are selected, a
caution triangle will be displayed in the tile header. Hovering over the triangle with the
mouse will display a tooltip notifying the user that they have exceeded the maximum number
of sources and that the tile is not displaying all parent data.

Default Context
Some tiles can be loadedwith a default display by using the "Default Context" text box. In the
"Default Context" text box, type in the record name to be displayed by default when the tile
launches e.g., Point ID, Site, PLNK, Model etc... Press [Enter] to load the context into the tile.
Click to save the tile context. The saved configuration loads when the
dashboard is opened from the menu.

A tile cannot have a parent tile in order to set a default context.

If a tile is parented the button is disabled. However, you can still use
the text box to change the context of the tile. The tile data that is displayed is the last
command given from the user. For example, the AOR tile is the parent to the Alarm List tile.
Clicking a button from AOR populates the alarm list. From the Alarm List tile, type a record
name into the "Default Context" text box and press [Enter]. The alarm list refreshes and
displays data from the record name and not from the parent tile.

Figure 8: Parent and Default Context
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Smart Tiles

Alarm Detail
The Alarm Detail tile displays additional alarm point information. This includes subdriver alarm
detail, notes associated with the alarm, and alarm history pertinent to a specific alarm or the
same alarm across multiple devices.

Figure 9: Alarm Detail Smart Tile

Alarm Duration
The Alarm Duration tile displays a chart of alarms that represent how many days alarms have
been standing.

Figure 10: Alarm Duration Smart Tile

Alarm List
The Alarm List tile is a real-time display of alarms currently in your network. Use the Alarm List
tile to acknowledge alarms, assign them to incidents, put associated devices into maintenance,
and to help trouble issues with your devices.

Figure 11: Alarm List Smart Tile
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Smart Tiles

AOR
The Area of Responsibility (AOR) tile displays your AOR areas and incident groups. Several
layouts are available including buttons for each area or incident group or charts to indicate the
number of alarms based on alarm priorities or the number of alarms in each of the entities in
the area or incident group.

Figure 12: AOR Tile Example

Device Detail
The Device Detail tile displays detailed information about devices in your network including
device structure and device backups.

Figure 13: Device Detail Smart Tile
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Smart Tiles

GIS
The GIS tile displays site information geographically, showing the highest priority alarm status
for the current context for each site. This tile functions as both a parent tile to set the context
of its child tiles and as a child tile to display the sites associated with the parent tile’s context.
Sites are automatically de-cluttered to limit overlap. Multiple map styles, weather radar and
Shapefile overlays are also supported.

Figure 14: GIS Smart Tile

Selector
The Selector smart tile is a simplified version of Telenium Managers Client Suite record selector.
The Selector tile functions as a parent tile for other tiles to set their context. The selector can
display different lists of entities depending on the what tile it is parented to.

Figure 15: Selector Smart Tile
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File Menu

File Menu
The file menu allows users and admins to configure and save their dashboards in the Telenium
Smart Tiles application.

New Session
Create new dashboards to save locally or share with other users on the database.

1. From the menu select .

2. Click the button. The "Add Smart Tiles" page is open.

3. Double-click the smart tile you want to add to your blank dashboard. A new dashboard will
open with only 1 tile visible.

4. Navigate back to the "Add Smart Tiles" page by selecting > and continue to
add tiles to complete your new dashboard.
You can add multiple tiles, without returning to the new dashboard, by right-clicking on a tile
and selecting Add. Click the [<] button to return to your new dashboard.

l Click and drag tile headers to arrange the dashboard.

l Hover, click and drag tile borders to adjust the length and width of the smart tiles.

l Use the button to pin the tile to the side of the dashboard window, click the tab to
open the tile.

l Click the button in the tile header to see more organizational tile options.
5. Once you are done creating and organizing your dashboard. Click the ribbon tab and

select .
6. Input a name and a description for the new dashboard.

7. Enable the checkbox if you want to share the dashboard with other users on the
database.

8. Click the button to save your new dashboard layout.

9. The new dashboard is added to the "Your Dashboards" pane in the menu.

Click the button in the menu to open a Smart Tiles session in a new window.

Smart Tiles
The menu option displays Telenium's smart tiles. Double-click or right-click and
select "Add" on a tile to open it in your active dashboard. Default tile information will be blank
until you assign a default context or parent tile entity reference.

Figure 16: Smart Tiles Menu Option
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File Menu

Open and Manage
The menu option shows existing dashboards that can be opened, deleted, and
enabled as global dashboards. Dashboard names and descriptions are sorted alphabetically and
can be edited and saved from the "open andmange" menu option.

Figure 17: Open & Manage

Global and Shared Dashboards
The "Global and Shared Dashboards" pane displays a list of available dashboards that other
users and admins have created and shared. Double-click to open the dashboard layout. Right-
click to open the dashboard in the current window, open the dashboard in a new window,
create a copy of the dashboard or delete the dashboard. Creating a copy of the dashboard will
move the copied dashboard to the "Your Dashboards" section.

Your Dashboards
The "Your Dashboards" pane displays a list of dashboards that you have created or copied to
your user account. Double-click to open the dashboard layout. Right-click to open the
dashboard in the current window, open the dashboard in a new window, create a copy of the
dashboard or delete the dashboard.

Dashboard Info
Selecting a dashboard from the "Global & Shared Dashboards" or "Your Dashboards" pane
populates the "Dashboard Info" pane. A description of the dashboard and the user who created
it is displayed. If the dashboard is modified, the users name is displayed as well as when the
modification wasmade. In the "Dashboard Info" pane you can enable the dashboard to be
viewed and used globally by enabling the check box.
Clicking the button, next to the name of the dashboard, allows you to change the name
and description of the selected dashboard. Click the button to keep your changes.
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File Menu

Save and Close
The menu option saves the context of the active tiles and the layout of the
current dashboard. In the menu option input a name and give a description
to your dashboard. Enable if you want to save the dashboard layout for other users
on your database to use. Click the button to save your dashboard. If a dashboard exists
with the same name, a dialog opens asking to overwrite the existing dashboard. Give the
dashboard a new name or click to overwrite the existing database. The saved dashboard is
available from the menu option.
The menu option closes the application. If changes were made to the dashboard or a tile
without saving a dialog will appear.

Figure 18: Save As

Help and About
The menu option opens the Smart Tiles webhelp in your default web browser.
The menu option opens a "About Smart Tiles" dialog that displays version and date
information for the application. Each individual smart tile version number is also displayed.

Figure 19: About Smart Tiles Dialog
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Alarm List

Alarm List
The Alarm List tile is a real-time display of alarms currently in your network. Use the Alarm List
tile to acknowledge alarms, assign them to incidents, put associated devices into maintenance,
and to help trouble issues with your devices.
Alarm lists displaying under alarm queue headers are filtered using the zFILTR record defined
on the users zLOGON record. If no filter is defined the global default SYS$FILTER is used.
SYS$FILTER displays all of the 99 possible alarm priorities.
To control which alarms display in the alarm list use any of the followingmethods:

l Click an alarm queue button from the AOR smart tile.

l Select a record from the Selector tile.

l Click a site node from the GIS tile.

l Enter a record name in the default context box.

By default, alarms are sorted chronologically from newest to oldest by their local time stamp
displayed in the "Time" column.
Use the keyboard shortcut [Ctrl]+F to display a "Full Text Search" text box to find a letter,
word, or phrase within the alarm list smart tile.
If multiple sources are selected the Alarm List tile is tabbed to display all the sources in a single
tile (up to 10). If the AOR smart tile is the parent tile, the tab header(s) in the alarm list will
display the AOR name and the AOR button selected e.g., (AOR Based on Priority:PRIORITY 31-
40).

Figure 20: Alarm List Tile
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Alarm List

Alarm List Ribbon
In the Alarm List ribbon users can pause, filter, export, and acknowledge alarms in the alarms
list. In the "Edit" tab of the ribbon users can make changes to the default layout of the alarm
list. Click the [Refresh] button in the "Smart Tile" ribbon group to refresh the Alarm List tile.

Navigate
The Alarm List tile can display up to 100 alarm counts onto one page. Use the
"Navigate" ribbon group in the toolbar to control the paging of the alarm list.

l Previous - go to the previous page of the alarm list.

l Next - go to the next page of the alarm list.

l Pause - pausing the alarm list allows time to view alarms while incoming alarms wait until
the list is resumed.

Figure 21: Navigate Group

Filter
Applying a priority filter from the"Filters" ribbon group causes the alarm list to display alarms
based on priority (e.g. Critical, Major, Minor, 11-20, 51-60, Maintenance) andmask alarms
from appearing in the alarm list. The selected filter automatically applies to the alarm list smart
tile.
Priorities are defined on filter (zFILTR) records to allow maximum flexibility. On start-up the
application uses the filter defined by the zLOGON record (default is SYS$FILTER).
Example
Assume your log in account permits you to view all alarms. However, you only want to see
alarms with priorities 1-10. Given no alarm queue button to display those priorities, you can
apply an existing filter. The alarm list will only displays alarms with priorities 1-10.

1. Select a priority from the "Filters" list box located on the ribbon.

2. Select any defined filter.

3. Alarm List displays only filtered items. Alarms masked by the filter disappear from the list.

Figure 22: Filters Group
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Alarm List

Show
The [Hide/Show Unacknowledged Normals] and [Hide/Show Partitioned Alarms] buttons apply
a filter to the alarm list. When the [Unacknowledged Normals] button is disabled, the alarms
displayed in the Alarm List include "unacknowledged alarms" and "acknowledged alarms". If
the button is enabled, the alarms displayed in the Alarm List include "Unacknowledged
Normals" as well.
When the [Partitioned Alarms] button is disabled, the alarms displayed in the Alarm List do not
include alarms that are in a partition category. If the button is enabled, the alarms displayed in
the Alarm List include all the alarms that are in an alarm partition. See the "Assign to ... group"
topic under the "Context Menu" section for more information about alarm partition groups.

Figure 23: Show Group

Export
You can export the alarm list data to either a CSV or Microsoft Excel file. On the toolbar in the
"Export" group click the [To CSV] or [To Excel] button to open a "Save As" dialog box and save
the data accordingly.

l Displayed Alarms - alarms that are visible on screen are written to the CVS/Excel file.

l Pages - the selected pages are written to the CSV/Excel file.

l All - all alarms are written to the CSV/Excel file.

Figure 24: Export Group
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Alarm List

Acknowledge Alarms
New alarms display in the alarm list with a blinking condition. Alarms can be acknowledged as
individuals or in selected groups.
If equipment installation or network servicing activity creates many alarms of low importance
you can acknowledge a selection of alarms or an entire page. Conversely, if a large number of
alarms normalize, you can clear them from the list all at once.
If the alarm condition has a suffix of a plus sign (+), it means the alarm has been cleared (e.g.,
Mounted+).

You are required to have proper permissions to acknowledge alarms. Contact your system
admin if you are given an error message dialog when trying to acknowledge alarms.

l Acknowledge alarms by selecting the alarm and clicking the [Selected] button in the
"Acknowledge Alarms" group in the ribbon.

l Acknowledged alarms stop blinking and normal acknowledged alarms disappear from the
list.

l To select multiple alarms use [Shift]+click (consecutive) or [Ctrl]+click (individual).

l Acknowledge all of the alarms within the tile display by clicking the [Visible] button.

l Acknowledge all normal alarms within the tile display by clicking the [Normals] button.

Figure 25: Acknowledge Alarms Group

Clear Alarms

l Clear - clears the selected acknowledged alarm from the alarm list.

l Force Clear - clears the selected alarm from the alarm list, even if isn't acknowledged.

Figure 26: Clear Alarms Group
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Alarm List

Edit Layout Tab
The Alarm List smart tile gives you the option to save changesmade to the tiles default
settings. Customize the Alarm List tile by making changes to the following:

l Move and size columns.

l Change the condition layout (make the text or cell the alarm status color).

l Toggle what alarm column information displays.

Save
Default and custom layouts are stored in the SQL database. Use the "Save Layout" ribbon
group to assign a layout to an entity (e.g. model, site, AOR, partition group). Saving custom
layouts include columns and optional theme. If the theme is set and locked in the custom
layout then that theme will supersede the user's theme.
Once you are done making changes to the default layout of the Alarm List tile. Click the desired
save option in the "Save" ribbon group.

l As Default - saves the table layout for all alarm lists loaded into the tile.

l For 'xyz' - saves the layout for the current record.

l For All Sites - saves for all current record types, sites, NEs and groups.

Figure 27: Save Layout

Layout
Select the way the alarm condition column is displayed in the Alarm List.

l Foreground - the condition column text is highlighted in the alarm status color.

l Background- the condition column cell background is the alarm status color.

l Row Color - select a color from the drop-down menu to change the color of the table row.

l Off-Row Color - select a color from the drop-down menu to change the color of the alternate
table row.
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Alarm List

Columns
Select what column information is displayed in the Alarm List smart tile by enabling or disabling
the corresponding check boxes in the "Columns" ribbon group e.g., AID, condition, point ID,
site description, time etc...

Figure 28: Columns Group

Columns can be arranged in any order by dragging them to new locations.
Column changesmust be savedmanually. If you close the Alarm List tile without saving your

changes, the changes are lost.
Move Columns:

1. In the column header, click and hold the left mouse button and drag the column left or right.

2. Release the mouse button to drop the column in its new location.

3. Click a [Save] button in the toolbar.

Change column width:

1. Place the mouse cursor on a column header right edge.

2. Ensure the cursor shape changes to a double-headed arrow.

3. Drag the column edge to the desired width and release the mouse button.

4. Click a [Save] button in the toolbar.
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Alarm List

Ticketing Tab
The "Ticketing" tab is only available to users with Maximo ticketing software.

The "Ticketing" tab in the ribbon is used to create, acknowledge, and ignore alarm tickets in the
Alarm List smart tile.
Assign a ticket to an alarm list entry:

1. Click the "Ticketing" tab in the ribbon.

2. Select an entry from the alarm list and click the [Create Ticket] button.

Alarm list entries can only have one ticket assigned to them at a time.

3. The alarm entry is given a ticket number and new priority number.
View the ticket number and priority by enabling the "Trouble Ticket" and "Priority"
columns in the "Edit Layout" tab.

The alarm priority number assigned is setup in Telenium Managers DBM application on the
MAXSRV record.

Figure 29: Ticketing Ribbon Group

Users can select each individual alarm in the alarm list to assign a ticket or select a series of
lines to create sequential tickets. Assign tickets to more than one entry in the alarm list by
using [Shift]+click and [Ctrl]+click to select multiple entries and then click the [Create Ticket]
button. Each entry will get its own ticket number. You can select more than one troubled ticket
entry to acknowledge or ignore.

Create Ticket
The creation of a ticket assigns ticket numbers to alarm list entries and changes the alarm
priority number. If more than one point is selected, a ticket will be created for each of the
selected points. A ticket cannot have more than one point assigned to it. To view a list of alarm
entries with tickets assigned to them, click the corresponding priority entry in the "AOR" smart
tile. View ticket numbers by enabling the "Trouble Ticket" column in the "Edit" tab.

Acknowledge
The [Acknowledge] button is permitted only on those tickets that are “Open”. Once
acknowledged, a message is sent to acknowledge the alarm and the ticket has an updated
status of “Acknowledged”. This process acknowledges the alarm within the Telenium system if
it is not already acknowledged.

Ignore
The [Ignore] button will release the points from the "Trouble Ticket" priority filter and put the
alarm point back to its original priority in the alarm list. There will no longer be a touble ticket
number associated with the entry.
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Alarm List

Context Menu Options
Right-click an alarm from the list to get a context menu that allows you to assign the alarm to a
partition, add comments, apply functions, and launch other Telenium applications in relation to
the alarm.

Alarm Comments
Alarm comments can be created and displayed. If a field technician reports that four hours are
needed to resolve an alarm, a comment can be inserted to inform other operators on this
situation.

Create and Edit Alarm Comments

1. Right-click an alarm and selectAlarm Comments>View/Edit from the context menu.

Figure 30: Alarm Comments Context Menu

2. Enter a title and comment in the “Alarm Comments” dialog box and click .

If the comments column is not displayed, select the Edit tab and enable the "Comments"
option in the "Columns" ribbon group.

Figure 31: Alarm Comments Dialog

Clear Alarm
Clears the selected acknowledged alarm from the alarm list.

Force Clear Alarm
Clears the selected alarm from the alarm list, even if it wasn't acknowledged.
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Alarm List

Assign to DELAYED Group
If there is a situation which is causing an alarm to keep generating it can clutter up your alarm
list. The "Assign to DELAYED Group" option is available to move alarm points to the suppressed
partition to hide them from your list.

1. Right-click on an alarm from the alarm list.

2. SelectAssign to DELAYEDGROUP.
3. In the "Assign to Alarm Partition" dialog select the desired disable alarm options:

l SUPPRESSED – keeps the alarm in the SUPPRESSED partition for the set amount of
time. In Telenium Managers "Alarm Partitions Manager" an advanced function can be
set to the "Suppressed" alarm partition.
<NONE> - keeps the alarm in the partition until you remove it.
DISABLEUNTILNORMALCUST - keeps the alarm in the partition until it reaches a
normal condition.
KeepFor24Hours - keeps the alarm in the partition for a 24 hour time period.
Keep ForTimePeriod - keeps the alarm in the partition for a set period of time. When
you assign the alarm to this advanced function a "Enter function parameters for
KeepForTimePeriod" dialog will open to set when the entry will be removed from the
partition.

l Scope- Selecting "Alarm" adds the alarm(s) to the partition.
Selecting "AID" adds the zNECLS to the partition.
Selecting "Network Element" adds the network element to the partition.
Selecting "Communications" adds the zCOMM to the partition.

Figure 32: Assign to Alarm Partition Delayed Dialog

4. Click the button to assign the alarm to the selected alarm partition.

5. Remove an alarm early from a delayed partition by using the "Alarm Partitions Manager"
application in Telenium Manager.
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Alarm List

Assign to General Group for Disabled Alarms
When a situation is expected to generate many non-critical, non-service affecting alarms the
option to move alarm points to the disable partition is available.

1. Right-click on an alarm from the alarm list.

2. SelectAssign to General Group for Disabled Alarms.
3. In the "Assign to Alarm Partition" dialog select one of the following disable alarm options:

l DISABLE24HOURS – keeps the alarm in the DISABLE24HOURS partition for 24
hours, unless you re-enable it by removing it from the partition.

l DISABLECUSTOM – lets you customize the date and length of time for the alarm to
be disabled. When this option is selected the "Enter function parameters for
DISABLECUSTOM" dialog box displays. Select the date using the calendar option and
enter the time for the alarm to be re-enabled and click .

l DISABLEUNTILNORMAL – keeps the alarm in the DISABLEUNTILNORMAL partition
until it is normal.

l Scope- Selecting "Alarm" adds the alarm(s) to the partition.
Selecting "AID" adds the zNECLS to the partition.
Selecting "Network Element" adds the network element to the partition.
Selecting "Communications" adds the zCOMM to the partition.

Figure 33: Assign to Alarm Partition Disable Dialog

4. Click the button to assign the alarm to the selected alarm partition.

5. Remove an alarm from a disabled partition by using the "Alarm Partitions Manager"
application in Telenium Manager.
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Alarm List

Assign to MAINTGROUP
The maintenance partition is useful when maintenance work is being done on the database.
When you put an alarming network element into the maintenance partition, the actual alarms
are moved to the partition and removed from the alarm list.

1. Right-click on an alarm from the alarm list.

2. SelectAssign to MAINTGROUP.
3. In the "Assign to Alarm Partition" dialog select one of the following maintenance alarm

options:

l IN_MAINTENANCE – places the alarm in the IN_MAINTENANCE partition until you
remove it from the partition.

l MAINTENANCE24HOURS – places the alarm in the MAINTENANCE24HOURS alarm
partition for 24 hours or until you remove it from the partition.

l MAINTENANCECUSTOM – lets you customize the date and length of time for the
alarm to be in the MAINTENANCECUSTOM partition. When you select this option the
"OpenParameters for:MAINTENANCECUSTOM" dialog box displays. Select the time
and date for the alarm to be taken out of the partition and click .

l Scope- Selecting "Alarm" adds the alarm(s) to the partition.
Selecting "AID" adds the zNECLS to the partition.
Selecting "Network Element" adds the network element to the partition.
Selecting "Communications" adds the zCOMM to the partition.

Figure 34: Assign to Alarm Partition Maintenance

4. Click the button to assign the alarm to the selected alarm partition.

5. Remove an alarm from a maintenance partition by using the "Alarm Partitions Manager"
application in Telenium Manager.
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Alarm List

Apply Functions
Three options display under the Apply Function feature: ExceededEvcount, Auto-Acknowledge,
and Noise Suppression. The ExceededEvcount option raises an alarm if the specified threshold
is exceeded.

Figure 35: Apply Functions Context Menu

ExceededEvcount
If an alarm is raised and then normalized a number of times it can be difficult to catch in the
alarm list. You can set the event count to a specific number so if an alarm is normalizedmore
than the set count an alarm is raised.
Auto-Acknowledge
Right-click an alarm and select Apply Function>Auto-Acknowledge>Auto Acknowlege
to force alarm list to auto-acknowledge the selected alarm.
Noise Suppression
The noise suppression algorithm reduces the cycling an operator sees if the alarm is constantly
changing state. There are 3 parameters required to define the algorithm: alarm count, period
and clear time. The alarm count and period define how many instances of the alarm need to
occur in the defined period to trip the suppression state. Once the alarm is in a noise
suppressed state, the alarm stops cycling back to a normal state and remains solely in the
alarm state. Clear time which indicates how long the raw DI state must remain steady in its
clear state before the alarm is removed. Until this time has elapsed, the operator continues to
see the DI as in alarm.
The Predefined setting for noise suppression in the alarm list is set to the following values:

Alarm Count: 5
Period: 10
Clear Time: 5

This means that if you apply noise suppression to an alarm, and the alarm clears and re-alarms
5 times in a period of 10 seconds or less. The alarm list only shows you the original alarm. It
doesn't show it clearing, then re-alarming. The alarm will only normalize if it is clear for a
minimum of 5 seconds.
Apply Noise Suppression by right-clicking on an alarm, selectingApply Function>Noise
Suppression>Predefined (5-10-5).
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Manage References
See Database Manager (DBM) help for information regarding this feature.

Manage Group Membership
See Database Manager (DBM) help for information regarding this feature.

Locate
View the site in Graphical Screen Manager.

Provision
Opens the NE in element provisioner.

Applications
Launch a Telenium Manager application in relation to the alarm list entry.

Figure 36: Context Menu - Applications
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Alarm Detail
The Alarm Detail tile displays additional alarm point information. This includes subdriver alarm
detail, notes associated with the alarm, and alarm history pertinent to a specific alarm or the
same alarm across multiple devices.
Right-click within the Alarm Detail tile to get a context menu that allows you to assign the
alarm to a partition, add comments, apply functions, and launch other Telenium applications in
relation to the alarm. See the "Context Menu Options" on page 23 in the "Alarm List" section
for more information.
Click the [Refresh] button in the "Smart Tile" ribbon group to refresh the Alarm Detail tile.

Details
By default, "details" information is displayedwhen opening the "Alarm Detail" smart tile.
If "details" is not displayed, select the "Alarm Detail" tile, and click the [Details] button in the
"Alarm Detail" group in the ribbon.
The "Alarm" section updates as the alarm's information changes. The "Last Normalized"
section contains the alarm's information before its current state.

l The description of the alarm is shown highlighted in the alarm condition color.
In this example "FULL-UPDATE" has a "completed" alarm condition and is highlighted in
green.

l The point ID of the alarm is highlighted in blue. "QAHOST-1" in this example.
Hover your cursor over the point ID to get a tooltip that shows the point IDs device address,
description, model type and zCOMM.

l Following the point ID, at "CALGARY" in this example is the site of where the alarm took
place.
Hovering over the site will give location information.

l The date and time when the alarm occurred and the duration of the alarm are displayed
below the alarm description and point ID.

l Maint Region - the zMAINT record in the database. Assigned to zNEs or zSITEs.

l Ticket - the ticket number pertaining to the alarm.

l Priority- the alarm priority number.

l State - 1 means currently in alarm, 0 means not in alarm.

l Condition – the condition of the alarm (normal, critical, warning, etc).

l Ack By – who acknowledged the alarm.

Figure 37: Alarm Detail Tile
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History
The history option allows you to view the local alarm history stored in the database. The
number of history entries stored in the logs at the NE and global level is determined from the
tunable parameter found in the $NODE record. Site and group levels show history for all NE's
within them (to the entry limit for each NE).
You can view alarm history for specific zNE records by clicking the desired record from the Alarm
List, AOR, etc...
The Alarm Detail tile must be set as a child of another SmartTile (AOR, TCRS, Chrono etc..) in

order to display information.
View the alarm history by selecting the Alarm Detail tile and clicking the [History] button in the
"Alarm Detail" group in the ribbon.
Historical data related to this alarm is displayed. A time plot with ranges (day, week, month,
quarter, year, etc) and alarm duration is shown depending on what button you select.

l This Alarm - displays the historical data of the specific alarm.

l This Class - displays all alarms of this type across the entire system.

l The NE - displays all alarm data of the network element.

l The Site - displays the alarm data on the specific site.

l The Alarm, all NEs - displays the selected alarm data across all network elements.

Figure 38: Alarm Detail - History
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Notes
Alarm notes can be created and displayed. If a field technician reports that four hours are
needed to resolve an alarm, a comment can be inserted to inform other operators about this
situation.
View the alarm notes by selecting the Alarm Detail tile and clicking the [Notes] button in the
"Alarm Detail" group in the ribbon.
If there are no notes then the button will be visible. Add a note by entering a title
and comment in the Alarm Detail smart tile and clicking the button.

Figure 39: Alarm Detail - Add Notes

The note will be added and the button becomes the button. Click the
button to remove the note.

Note options:

l Persist in future occurrences - enable if you want the same note to be applied if the alarm is
activated in the future.

l Remove when alarm clears - enable if you want the note to be removed when the alarm
clears.

Figure 40: Alarm Detail - Clear Notes
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AOR
The AOR smart tile displays andmanagesmultiple alarm queues based on defined areas of
responsibility (AORs). Several layouts are available including buttons for each area or incident
group or charts to indicate the number of alarms based on alarm priorities or the number of
alarms in each of the entities in the area or incident group. The tile provides options to filter
AORs and incidents as well as customize docking positions. The AOR smart tile can be used as a
parent tile to populate other smart tiles. Click on a label, slice, button, or bar graph to select the
area and populate another tile. e.g., display alarm information by making the AOR smart tile
the parent tile to the Alarm List smart tile. Selecting a button from the AOR populates the
alarm list.
System administrators color code alarms so their priority reflects the severity of the originating
alarm. AOR displays color-coded alarm point states in real-time.

View AORs
By default the AOR smart tile opens with whatever AOR/Incidents, view, and display that were
open prior to the tile being closed.
To view different AORs:

1. Enabled/disable AORs and incidents in the "AOR/Incidents" ribbon group.

2. Select a view.

3. Select a display.

4. [Optional] Change view options settings.

Alarm queue headers display in the selected AORs. Alarm queue buttons/charts indicate when
alarm conditions exist. Unacknowledged alarms display as blinking buttons. Acknowledged but
unresolved alarms retain their alarm priority color, but stop blinking. When the network
element condition returns to its normal state and you acknowledge the normalized condition,
the alarm points return to their normal color.
The area of responsibility (zAOR) record is used, alongwith the zAREA record, to define the
alarm queue buttons and specify which alarms are listed by each queue.
Click the [Refresh] button in the "Smart Tile" ribbon group to refresh the AOR smart tile.

Figure 41: AOR SmartTile - Button

AOR and Incidents
AORs are shown in the left cell and incident groups, within the AOR, in the right cell. Enabling a
check box will display the AOR and incident group in the AOR SmartTile. Disabling a checkbox
will hide the AOR and incident. Clicking the [Show All] button enables all the incident groups in
the selected AOR.

Figure 42: AOR/Incidents Group
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Display
Select a display option to determine what alarm count information is displayed in the
AOR smart tile.

l Summary displays an overall alarm count for each area within the selected AOR.

l Priorities display the alarm count for each specific priority within the AOR.

l Entities show the alarm count for each point ID of the AOR.

Figure 43: Display

Summary

l The pie and doughnut views display one control per selected AOR in the "AOR/Incidents"
ribbon group.

Figure 44: Summary Pie

l The horizontal and vertical charts display the alarm count for each child area that has an
alarm count greater than 0.

Figure 45: Summary Vertical Bar

l The "button" view is not available in the "summary" display option.
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Priorities

l In the pie, doughnut, horizontal, and vertical views, a separate tab is opened for each
AOR enabled in the "AOR/Incident" ribbon group.

Figure 46: Priorities Doughnut

l A horizontal or vertical chart is displayed for each selected area from the "AOR/Incidents"
ribbon group.

l The horizontal and vertical charts display the alarm count for each child area that has an
alarm count greater than 0.

Figure 47: Priorities Horizontal

l The "button" view fits all AORs in a single tab tile display.

l One button is displayed per area in the priorities "button" view.

l Hover over a button to display alarm counts for each priority in the area that has an alarm
count greater than 0.

Figure 48: Priorities Button
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Entities

l In the pie, doughnut, horizontal, and vertical views, a separate tab is opened for each
AOR enabled in the "AOR/Incident" ribbon group.

l The "button" view fits all AORs in a single tab tile display.

Figure 49: Entities Pie

l A horizontal or vertical chart will be displayed for each selected area from the
"AOR/Incidents" ribbon group.

l The horizontal and vertical charts display the alarm count for each child area that has an
alarm count greater than 0.

Figure 50: Entities Horizontal

l One button is displayed per area in the entities "button" view.

l Hover over a button to display a list of child entities and their alarm counts for all entities
that have an alarm count greater than 0.

Figure 51: Entities Button
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Views
The AOR smart tile offers various display types. The button view acts similar to the AOR bar in
Telenium Manager. Data is grouped and presented by areas of responsibility or partition folder.
Users can select which AOR buttons are displayed by enabling the desired AORs in the
"AOR/Incidents" ribbon group.
Chart views (pie, doughnut, vertical and horizontal bar) are displayed in a table layout in the
AOR smart tile. If multiple AORs are selected they are separated by tabs within the tile. The
user can set the number of columns displayed (max 10) in the tile in the "View Options" ribbon
group.

If the number of charts are less than the maximum number of columns, empty columns will
not be displayed.

By default, charts are sized to fit the horizontal space and a vertical scroll bar is added if the tile
is not tall enough to display all charts fully. However, the user can toggle vertical and horizontal
scrollbars using the "Fit" check boxes in the "View Options" ribbon group. This effects how
charts are sized in each column and row. If a chart becomes too small to be readable the labels
will not be displayed.

Figure 52: Views

Button

l The AOR label is displayed next to the buttons (zAOR description).

l Each button is labeled by the user. The area of responsibility (zAOR) record is used, along
with the zAREA record, to define the alarm queue buttons and specify which alarms are
listed by each queue.

l Right-click to show or hide all AOR buttons in the tile.

l Hover over a button to display alarm counts.

l Drag and drop a button onto an "Alarm List" child tile to populate the alarm list.

Figure 53: Button Example
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Pie and Doughnut

l Each slice is an area contained in the AOR and the slice size is based on the alarm count for
each area.

l Each slice uses the alarm color of the area.

l Each slice of the display shows the alarm count for that area.

Figure 54: Pie Example

l Areas with no alarms are not displayed.

l Slice labels show the area description or button text. If their is no description defined, the
alarm count is displayed.

l Each slice is selectable. When selected, the label and slice of the doughnut/pie is
highlighted. The slice expands further to show the selected piece.

Figure 55: Doughnut Example

Vertical and Horizontal Bar

l The chart label is the AOR description (or EPN if the description is not defined).

l The alarm count and areas of the AOR are displayed on the X and Y axis of the charts.

l The total alarm count is shown in brackets beside the alarm priority description.

l Selecting a bar or axis label highlights the bar with a bold outline.

l Each bar uses the alarm colour of the area.

Figure 56: Horizontal and Vertical Bar
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Show and View Options
The [Unacknowledged Normals] button reflects the state of the xIGNORENRM field on the
session record associated with any session used to display the AORs.
When the button is disabled, the alarm counts displayed in the AORs only include
"unacknowledged alarms" and "acknowledged alarms". If the button is enabled, the alarm
counts displayed in the AOR only include "Unacknowledged Normals".

l Columns - the number of columns displaying data within the AOR smart tile. The maximum
amount of columns you can have within the tile is 10.

l Fit Horizontally - enabling this option will make all data fit horizontally within the set tile size.

l Fit Vertically - enabling this option will make all data fit vertically within the set tile size.

Figure 57: Show and View Options
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Device Detail
The Device Detail tile displays detailed information about devices in your network including
device structure and device backups. Users can view, run, and save backup information from
the Device Detail tile.
As a child tile, if multiple entities are selected from a parent smart tile, device information will
be separated by tabs at the top of the tile. The newest entity selected is given focus. The tab
header contains a dynamically updating status alarm color as well as the AID name or the
name of the NE that the device detail information is referencing.
As a parent tile the Device Detail smart tile updates it's child smart tile when the selected entity
in the navigation panel changes or a link within the Device Detail main panel is clicked. E.g. if
Device Detail is the parent tile to GIS and the site link is clicked, the GIS tile will update to show
the site selected.
Click the [Refresh] button in the "Smart Tile" ribbon group to refresh the Device Detail smart
tile.

Figure 58: Device Detail - NE Selected

Navigation and Main Panel
The "navigation" panel displays a network element tree view displaying all the AIDs within the
NE. By default the tiles tab device name will be selected in the tree view. The panel can be
moved to any edge of the tile and can be sized, pinned, set to float, or set to auto-hide.
Right-click a network element within the "navigation" panel to get a context menu that allows
you to assign the alarm to a partition, add comments, apply functions, and launch other
Telenium applications in relation to the device. Right-click a blue link within the "main" panel to
see the same options. See the "Context Menu Options" on page 23 in the Alarm List section for
more information.

Figure 59: Navigation Panel
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If a network element is selected from the panel the Device Detail main panel will display the
NEs description, model type, TID, site location, customer name, and protocol data. The main
panel also shows if the devices comm is enabled and if it's a CIP device. You can also put the NE
into maintenance mode by enabling the "In Maintenance" check box.

Figure 60: Main Panel

Filter
You can filter status, date, and download information in the backups table by clicking the
button in the column header. In this example the "Status" filter menu is used. Enable the "fail"
or "success" check boxes to show only failed or successful backup rows in the table. Similarly
you can filter the backup table by date by clicking the button in the "Date" column and using
the drop down boxes to display backups from a specific time.

Figure 61: Status Filter Menu
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GIS
The GIS tile displays site information geographically, showing the highest priority alarm status
for the current context for each site. This tile functions as both a parent tile to set the context
of its child tiles and as a child tile to display the sites associated with the parent tile’s context.
Sites are automatically de-cluttered to limit overlap. Multiple map styles, weather radar and
Shapefile overlays are also supported.
The GIS smart tile displays a mapwith overlaid Telenium sites. Navigate the tile by panning and
zoomingwith the mouse andmouse wheel. The tile header contains the geographic
coordinates of the center of the map and the current zoom level. If the map's location is set by
a view record, the name of the view is included in the header.
The GIS tile can work as either a root, parent or child smart tile. However, the GIS smart tile
must be given a parent tile to display sites. From there, the GIS tile can become a parent tile to
populate data in another tile. In this example, the AOR tile is the parent tile to the GIS tile and
the GIS tile is the parent to the Alarm List tile. The "Red Deer" site is selected in the GIS tile
which populates the Alarm List tile.
Click the [Refresh] button in the "Smart Tile" ribbon group to refresh the data in the GIS tile.

GIS does not support filtering to an incident.
GIS shows current site alarm colors including the color from all incidents.

Figure 62: GIS Populating Alarm List
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Sites
Site icons are circular pushpins and clustered sites are rectangular pushpins . The center

of each icon contains the sites status color. A site's selection state can be toggled by left clicking
on the site icon. Sites that are selected are highlighted with a white center.

Figure 63: Sites

Tooltips
A site's tooltip contains a sites alternate name (if applicable) and list of the site components.
Each site component will contain a status box followed by the name of the component.

Figure 64: Tooltip

A clustered site tooltip contains the sites alternate names (if applicable) and a list of entities
that the pushpin represents. Each entity displays a status box followed by the name of the
component.

Figure 65: Clustered Site Tooltip
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View Ribbon Group
Clicking the reset button in the "View" ribbon group, resets the GIS smart tile to its default
settings. Any sites that are displayed in the tile are removed.
Clicking the clear selection button deselects any sites that are highlighted.

Figure 66: View Ribbon Group

Layers
The GIS smart tile map supports layers to display different information. The base layer of the
tile is the map that is always visible.
From the "Layers" ribbon group you can enable and disabled the "Sites" and "Precipitation"
layers. The "Sites" layer displays the Telenium network sites. The "Precipitation" layer displays
weather data from the National Oceanic and Atmospheric Administration (NOAA). A
button is displayed in the tile when "Precipitation" is enabled. The legend displays a color key
that demonstrates the color values of the radar precipitation rate (mm/hr) on the map.

Figure 67: Layers Ribbon Group

Weather data is gathered in 3 hour windows. You can animate the weather data in the GIS tile
by enabling the button. Every 30 minutes an image is captured and the 6 images
are cycled through to animate the GIS tile.

Figure 68: Precipitation Enabled
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Add Custom Layer
The GIS smart tile supports Shapefile custom layers. Add your own custom layer by clicking the

button in the ribbon. In the "Add Custom Layer" dialog input a Name, Source URI,
and a Data Source URI to define a shapefile that you would like to add as a custom layer. Click
the button to add the new layer to the list of available layers.

Figure 69: Add Custom Layer Dialog

Enable the layer check box to enable it in the GIS tile. The new custom layer is available to any
user that connects to the server.

Figure 70: Custom Layer
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Remove and Edit a Custom Layer
You can remove custom layers by clicking the button in the "Layers" ribbon
group. In the "Map Layers" dialog box remove any custom layer by clicking the Remove Layer

button next to the layer.

The "Radar" and "Sites" layers are in the GIS tile by default and cannot be removed.

Re-arrange the available layers to determine the order that the layers appear in the GIS tile.
Change the "z-index" number using the arrows. By default the base layer of the GIS tile is
"Radar" with a z-index of 1. In this example, "Sites" is 2 and "Custom" is 3. This means that
the custom layer is displayed on top of the two other layers with the sites layer between radar
and custom. The highest number of the layer in the z-index is the top layer displayed in the
GIS tile.

Figure 71: Map Layers Dialog

Radar cannot be changed from layer 1. The weather data is displayed as the bottom layer with
sites and other layers displayed over top. If you do not want to see a weather layer it is
recommended to disable "Radar" from the layers checkbox in the ribbon or change the opacity
to a smaller number.
Each layers opacity can be changed using the arrows in the corresponding rows. Opacity ranges
from 0.00 to 1.00, the higher the number the more solid the layer displays in the tile.
The order of the layers, the layer transparency level and the layers which are selected are
stored in the dashboard and are consistent across users, computers and sessions.
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Filtering
The "Filter" ribbon group allows you to filter the sites that are displayed in the smart tile.
The site filters are displayed in the drop-down list. Select one of the filter options from the drop-
down and only the sites associated with the records in the filter will be visible on the map.
When "none" is selected in the filter drop-down, all sites are visible.

Vis Loss
By default the sites in the GIS smart tile are displayed using the standard status color. Enabling
the "Vis Loss" option shows the percentage of devices at the site that are in a "visibility lost"
state.
The site icon is expanded to include text where the first number is the percentage of devices in
vis loss and the second number is the number of devices in vis loss. If you are at a zoom that
merges sites, the text is a sum of all the contained sites.

Figure 72: Vis Loss
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Map Style
The GIS smart tile supports multiple map providers. Click the desiredmap provider button in
the "Map Style" ribbon group to change the display of the GIS smart tile.

Figure 73: Map Style Ribbon Group

Map View
Each map style has a number of different views that can be selected using icon in the
navigation bar at the bottom of the GIS tile. Site icons and their alarm status color are not
altered when choosing a different map style.
Change the map view by:

1. Select your desired map style provider. Click "OSM", "Thunderforest" or "ArcGIS" from the
"Map Style" ribbon group.

2. Hover over the icon in the navigation bar to open a list of available views.

3. Click an option to alter how the map layer is displayed in the GIS tile.

Navigation Bar

l Hover over the icon to adjust the zoom level.

Figure 74: Zoom Level

l The coordinates display the location of your mouse cursor on the map.

l The directional arrows can be used to navigate the map. Click the to hide the navigation
bar control options.

Figure 75: Navigation Bar
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Context Menu Options
Right-click on a site to get context menu options that allows you to assign the site NEs to a
partition, add notes, and launch other Telenium applications in relation to the site.

Move Site NEs into DELAYEDGROUP
If there is a situation which is causing an alarm to keep generating it can clutter up your alarm
list. The "Move Site NEs into DELAYEDGROUP" option is available to move the NEs associated
with the site to the suppressed partition.

1. Right-click on a site on the GIS map.

2. SelectMove Site NEs into DELAYEDGROUP.
3. In the "Assign to Alarm Partition" dialog select the "SUPPRESSED" alarm option.

l SUPPRESSED – keeps the alarm in the SUPPRESSED partition for the set amount of
time. In Telenium Managers "Alarm Partitions Manager" an advanced function can be
set to the "Suppressed" alarm partition.
<NONE> - keeps the alarm in the partition until you remove it.
DISABLEUNTILNORMALCUST - keeps the alarm in the partition until it reaches a
normal condition.
KeepFor24Hours - keeps the alarm in the partition for a 24 hour time period.
Keep ForTimePeriod - keeps the alarm in the partition for a set period of time. When
you assign the alarm to this advanced function a "Enter function parameters for
KeepForTimePeriod" dialog will open to set when the entry will be removed from the
partition.

Figure 76: Assign to Alarm Partition Delayed Dialog

4. Click the button to assign the NEs to the alarm partition.

5. Remove an alarm early from a delayed partition by using the "Alarm Partitions Manager"
application in Telenium Manager.
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Move Site NEs into Gerneral Group for Disabled Alarms
When a situation is expected to generate many non-critical, non-service affecting alarms the
option to move the NE alarm points to the disable partition is available.

1. Right-click on a site on the GIS map.

2. SelectMove Site NEs into General Group for Disabled Alarms.
3. In the "Assign to Alarm Partition" dialog select one of the following disable alarm options:

l DISABLE24HOURS – keeps the alarm in the DISABLE24HOURS partition for 24
hours, unless you re-enable it by removing it from the partition.

l DISABLECUSTOM – lets you customize the date and length of time for the alarm to
be disabled. When this option is selected the "Enter function parameters for
DISABLECUSTOM" dialog box displays. Select the date using the calendar option and
enter the time for the alarm to be re-enabled and click .

l DISABLEUNTILNORMAL – keeps the alarm in the DISABLEUNTILNORMAL partition
until it is normal.

Figure 77: Assign to Alarm Partition General Group Dialog

4. Click the button to assign the NEs to the alarm partition.

5. Remove an alarm early from a disable partition by using the "Alarm Partitions Manager"
application in Telenium Manager.
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Move Site NEs into MAINTGROUP
The maintenance partition is useful when maintenance work is being done on the database.
When you put an alarming network element into the maintenance partition, the actual alarms
are moved to the partition and removed from the alarm list.

1. Right-click on a site on the GIS map.

2. SelectMove Site NEs into MAINTGROUP.
3. In the "Assign to Alarm Partition" dialog select one of the following maintenance alarm

options:

l IN_MAINTENANCE – places the NEs alarms in the IN_MAINTENANCE partition until
you remove it from the partition.

l MAINTENANCE24HOURS – places the NEs alarms in the MAINTENANCE24HOURS
alarm partition for 24 hours or until you remove it from the partition.

l MAINTENANCECUSTOM – lets you customize the date and length of time for the
alarm to be in the MAINTENANCECUSTOM partition. When you select this option the
"OpenParameters for:MAINTENANCECUSTOM" dialog box displays. Select the time
and date for the alarm to be taken out of the partition and click .

Figure 78: Assign to Alarm Partition Maintenance Group

4. Click the button to assign the NEs to the alarm partition.

5. Remove an alarm early from a maintenance partition by using the "Alarm Partitions
Manager" application in Telenium Manager.

Manage References
See Telenium's Database Manager (DBM) help for information regarding this feature.

Manage Group Membership
See Telenium's Database Manager (DBM) help for information regarding this feature.
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Record Notes
Add a note to site by right-clicking the site and selectingRecord Notes. In the "Notes" dialog
click the button to add a new note. Delete, save, refresh, print and export notes using the
dialogs corresponding toolbar buttons. You can view different notes about the site by clicking
the "Note" tabs.

Figure 79: Notes Dialog

Locate
View the site in Graphical Screen Manager.

Applications
Launch a Telenium Manager application in relation to the site entry.

Figure 80: GIS Context Menu - Applications
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Alarm Duration
The Alarm Duration tile displays a chart of alarms that represent how many days alarms have
been standing. You can select the site by making a selection from the "Site" drop-down box.
"Default" data is displayed if a specific site isn't selected (default data is all the alarms that have
a site on your database). Hover over an alarm trend point to display the alarm count and days
open tooltip. The Alarm Count y-axis adjusts to fit the total number of alarms on the selected
site.

The chart displays acknowledged and unacknowledged alarms on the selected site.

The Interval text box is used to set the alarm trend interval of days on the x-axis of the graph.
Use the spinner controls or input a numerical value (lowest you can set is 2) and press [Enter]
to save and change the day intervals.
The Limit Label text box is used to set the "Days Open" x-axis of the alarm trend graph. Use the
spinner controls or input a numerical value and press [Enter] to increase or decrease the
maximum number of days shown in the graph.

Figure 81: Alarm Duration Smart Tile

The Alarm Duration tile can graph data using other smart tile sources by parenting another tile
to the "Alarm Duration" tile. If a source is selected with multiple sites, e.g., a group of sites in
GIS. The "Showing" label changes to a "Parent Selection" label and the sites are listed.

Figure 82: Parent & Default Context
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In this example the AOR tile is the parent to the Alarm Duration tile. Five area buttons are
selected from the AOR tile. The Alarm Duration tile charts the alarm data from the AOR sites.
The sites alarm duration data is displayed and the "parent selection" header is showing the five
AOR sources.

Figure 83: Parent Selection

Only 10 parent sources can be displayed at a time. If a source is selected with more than 10
sites, a caution icon is displayed in the tile. The first 10 sites from the source are charted
and the source(s) are listed in the "Parent Selection" header.
Click the [Refresh] button in the "Smart Tile" ribbon group to refresh the alarm duration data.
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Selector
The Smart Tiles Selector is a simplified version of Telenium Managers Client Suite Record
Selector. The Selector tile functions as a parent tile for other tiles to set their context. The
selector can display different lists of entities depending on the what tile it is parented to.
Parent the Selector to a child tile, select a record type from the ribbon, and double-click a record
entry to populate the child tile. You can also click and drag an entry to populate a child tile.
Click the [Refresh] button in the "Smart Tile" ribbon group to refresh the Selector tile list.

Figure 84: Selector

Record Type
Select a record type from the drop down box to populate the Selector tile. Some record types
are compatible with all tiles while others can only be usedwith specific tiles. Some examples of
the record types you can select are; alarm partitions, views, groups, NEs by model, and sites.
Depending on the record type selected, the Selector tile will display different context menu
options. See the ""Context Menu Options" on page 23" in the Alarm List topic for more
information.

Filter and Show
Filter the Selector list by inputtingmatch text (NE, site, group etc...) into the "Filter" box and
pressing [Enter]. This is helpful if you want to find a specific site and the record list is too long.

If there are nomatching records a dialog will open notifying the user.

By default the record list displays the alarm condition color on each site, NE, area etc... toggle
the alarm condition display on and off by clicking the [Alarm Condition] button in the "Show"
ribbon group.
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